Introduction

During the process of hardware debug and tuning of PCI Express® based systems using switches, it is important to have easy access to the configuration spaces of such devices. "IDT PCI Express Browser" software provides such access to the PCI configuration space of all the PCI/PCI-X/PCIe® devices within the computer running this software. The PCIe browser uses an elegant and user friendly graphical user interface (GUI) and is specifically tuned to provide complete read/write access to all member devices of IDT PRECISE™ family of PCI Express Switches and Bridges.

The PCIe browser can be used to:
- Display and/or modify contents of the configuration space/registers.
- Generate the data file used to program the serial EEPROM connected to the IDT PCIe device via SMBUS interface. The PCIe browser can also write (program) this data into the EEPROM available on the platform. Values are optionally loaded from this EEPROM to overwrite the default configuration values within IDT PCIe devices during power on.
- Help debug the device/system by saving snapshots of configuration/registers in dump files.

System Requirements

PCIe enabled computer/server running Windows 2000/XP or later, or Linux kernel version 2.4 / 2.6 (gtk2 library required) or later version.

Installation

The PCIe browser under Windows relies on a low level driver to access the PCI and PCIe configuration space. The driver is called "IDTIOPort.sys" on a 32-bit OS and "IDTIOPort64.sys" on a 64-bit OS. Both drivers are included in the installation package and are installed automatically during installation.

Run the program called "PCIeBrowserInstall". This program will install the required software package on your Windows or Linux machine. Once the installation program begins, the following screens are displayed sequentially. Windows installation screens are shown here. Linux installation screens look similar to these. Click on the appropriate buttons and enter appropriate information when asked.
IDT PCI Express® Browser Installation

Introduction

InstallAnywhere will guide you through the installation of IDT PCIe Browser.

It is strongly recommended that you quit all programs before continuing with this installation.

Click the 'Next' button to proceed to the next screen. If you want to change something on a previous screen, click the 'Previous' button.

You may cancel this installation at any time by clicking the 'Cancel' button.

Choose Install Folder

Where Would You Like to install?

C:\Program Files\IDT\PCIEBrowser

- Restore Default Folder
- Choose...

Cancel

Previous
Next
IDT PCI Express® Browser

Installing IDT PCIe Browser

Installing... pcibrowser.exe

InstallAnywhere by Zero G

Cancel

Install Complete

Congratulations! IDT PCIe Browser has been successfully installed to:

C:\Program Files\IDT\PCleBrowser

Press "Done" to quit the installer.

Cancel

PreviousDone
Using the PCIe Browser

Windows users may double-click on the PCIe Browser application icon to launch the application. Linux users may start the application by executing ". /pciebrowser".

When the PCIe Browser is started, it detects all of the PCI/PCI-X/PCIe devices in the system on which the PCIe Browser is running. The initial display shown in Figure 1, illustrates the details of the host PCI Bridge / Root Complex.

![Figure 1 PCIe Browser Display on Start-up](image)

To see all of the devices detected by the PCIe browser, left click on the [+] button and follow the tree as shown in Figure 2.
Note that a PCI Express switch is represented as a collection of PCI to PCI bridges - a bridge for every port of the switch. In all display screens, the PCI-PCI bridges are preceded by a blue icon and the PCIe endpoints are preceded by a red icon. Left clicking on a PCI-PCI bridge symbol expands the tree showing all the PCIe devices residing below the selected bridge in the PCI hierarchy. The status bar at the bottom of the PCIe browser window shows the Bus, Device and Function numbers of the selected PCIe device.

File Types

It is important to understand the two different types of files created and used by the PCIe Browser software.

- Configuration files: These are text files which contain information typically used or created by the PCIe Browser to create EEPROMs which will be used by the IDT PCIe devices at boot time. This information is, therefore, typically limited to PCI configuration space items that can be modified at boot time. Menu items "load", "save" and "save as" under the "File" pull-down menu item (explained later) deal with such files. Users are free to name Configuration files in any way they wish. However, for ease of identification, the file name extension ".cfg" is recommended.

- Dump files: These text files, different in their structure from the Configuration files, contain information which spans the "entire" PCI configuration space, including the extended space specified by the PCI Express standard. Menu items "dump" and "fill" under the "File" pull-down menu item (explained later) deal with such files. Users are free to name Dump files in any way they wish. However, for ease of identification, the file name extensions ".dmp" is recommended.
Displaying a Small Snapshot of the Device Status

A limited number of important items related to the status of a device can be displayed by taking the following steps:

- Select the device by placing the cursor on it and left-clicking the mouse button.
- Right-click the mouse button and select “Status” to display status of the device. Alternatively, you may click on the pull down menu item “Device” and select the option “Status”.

The contents of the PCI Express Capability Status Registers for device, link, and slot (if implemented) are displayed. Figure 3 shows an example of a display shown for a PCIe device manufactured by someone other than IDT, Inc. Figure 4 shows an example of an IDT PCIe device. Figure 5 shows an example of a non-PCIe device.

![Figure 3 Status of a PCI Express Device Not Manufactured by IDT](image1)

![Figure 4 Status of PCI Express Device Manufactured by IDT](image2)

![Figure 5 Status of a Device That is Not a PCI Express Device](image3)
Reading Configuration Space for the First Time

The configuration space registers of a device can be displayed by taking the following steps:

- Select the device by placing the cursor on it and left-clicking the mouse button.
- Right-click the mouse button and select “Details” to display the configuration space of the selected device. Alternatively, you may click on the pull down menu item “Device” and select the option “Details”. See Figure 6 below.

![Figure 6 Device Menu](image)

If any of the IDT PCIe Switch or Bridge devices are selected, the PCIe Browser display will resemble Figure 7. In this example, IDT PES12T3G2 switch is shown. The configuration space of a port can be displayed by selecting the appropriate tab (PORT 0, PORT 2, PORT 4 in Figure 7). Figures 8, 10, and 11 show expanded views of specific registers in the configuration space.

![Figure 7 Displaying IDT PCI Express Switch Configuration Space Registers (Collapsed View)](image)
Reading Configuration Space Selectively At Any Time

Initially, all registers are read from the device and displayed as explained in the previous section. This represents the snapshot of register values at the moment of opening the Device Window. However, register contents within the device may change as data flows through the device or as various hardware events occur. Such changes do not automatically get reflected in the Device Window. A new snapshot of the device contents, with required granularity, needs to be taken in order to see the most current status. This can be achieved with the “Refresh” pull-down menu item. Desired granularity can be selected by picking “Register”, “Port”, or “Device” under the “Refresh” menu, as shown in Figure 8.

![Figure 8 Updating the Display Using "Refresh"](image)
Modifying Configuration Space

There are several different types of icons that are used in the display. These are described in Figure 9.

Legend for Register Fields icons

- **Zero**
- **HWINIT**
- **Read Only – Clear**
- **Read – Write – Clear**
- **Read Only**
- **Read Only – Set by HW**
- **Reserved**
- **Read – Write – ‘1’ Clear**
- **Read – Write**
- **Locked**
- **Read – Write when Unlocked**

Legend for Register selection for storing in Configuration file

- **Non-selectable**
- **Selectable**
- **Selected**

Figure 9 Icons Used to Convey Specific Functionality

The PCIe browser allows users to modify selected items in the configuration space of IDT PCIe switch and bridge devices. As shown in Figure 10, the fields that can be modified are preceded by green icons, and the read-only fields are preceded by red icons.

Figure 10 Writing to the Device Registers Using “Store”
The fields preceded by green circles can be modified by checking the box against the bit-field as shown in Figure 11. For multi-bit fields, values can be entered in the decimal or hexadecimal numbering system. Once the register contents are changed, these can be written into the device as register, port, or device updates. In register update mode, only the contents of the selected register are updated. In device update mode or port update mode the applicable set of configuration registers are written. To perform this operation, use the drop down menu “Store” to select the appropriate granularity of the write operation. Note that only “fields” can be modified. Registers cannot be modified directly. Note that changed fields become bold in the display.

Figure 11  Modifying a Bit Field
**Register Write**

The value of any bits that make up a field within a register, and that is displayed as a hex value, can be changed by simply typing over the hex value that is displayed at any given time (refer to the Device User Manual for legal values of all bit fields).

For example, register 26 is initially shown to have a value of 0x0001 below.

A mouse click on the “+” sign on the left of the register shown above results in an expanded display as shown below, where all multi-bit fields are exposed. At this point, a new value can be written over multi-the bit field [15:04] as shown below, for example. This changed value of the multi-bit field is immediately reflected in the main register value in the top line as shown below.

However, the above step results in a change only in register set copies held in the GUI software and not to the actual silicon device. To write this value to the register within the actual silicon device, menu option Store->Register can be used as shown below.
Dumping/Loading Configuration Space

The PCIe browser allows users to save the contents of the configuration space registers into a file and also allows loading contents of the configuration space registers from a file. The first group under the "File" menu includes three selections: **Load**, **Save**, and **Save As**.

- **Load**: Opens a .cfg file and loads its content into the register window. A green check mark icon will precede every register in the .cfg file.
- **Save** and **Save As**: These are used to save all registers that are preceded by a green check mark icon to a .cfg file. The saved .cfg file can be converted to a .bin file at a later time. The .bin file is the EEPROM image file that can be programmed (burned) into an EEPROM. Please refer to section Creating EEPROM Image on page 14 for more details.

There are two types of register icons on the left side of the register names in the display. Only those with a green triangle in the icon can be selected for writing to the configuration file. To select or exclude a register, right-click twice on the Selectable icon (shown below).

Since the configuration file operates on double words, if the selected register width is less than 32 bits, the adjacent register which is a part of that double word is stored as well.

The second group under "File" menu includes two selections:

- **Dump**: This item is used to save the currently displayed values of all registers into a .dmp file.
- **Fill**: This item is used to open an existing .dmp file and load its contents into a register window.
Creating EEPROM Image

During power-up, the configuration space registers of IDT switch and bridge devices can be optionally initialized with values read from the EEPROM device residing on the SMBUS. The PCIe Browser allows users to create a binary image of the configuration space register contents, which can then be used to burn I2C/SMBUS EEPROM.

EEPROM Creation Overview

The "Create" menu item is used to select the IDT Switch or bridge device configuration as shown in Figure 12. This option results in the display of registers which can be modified according to the desired default settings. This gives the user an illusion of having a real device present, even when there is none present in the system. This allows a user to create an EEPROM image for a device even in the absence of the actual device in the system on which the PCIe browser is being run. After modification, the contents of the configuration space are saved in a binary file which can then be used to program the EEPROM.

Once the desired configuration is created using the “Create” menu, further actions can be taken using the pull-down menu item EPROM as shown in Figure 13.

The option “Convert to BIN” allows the user to save the current configuration to a binary file. This binary file can then be transferred to an EEPROM programmer for mass production or the file can be sent to another user (by email, for example) for replicating the EEPROM, debugging, etc.

The menu option “Program” enables the user to program the EEPROM populated in the current system directly through the IDT device without the need for removing the EEPROM, taking it to a EEPROM programmer, etc. This facility is very useful for system developers while they are in the trial modes and are investigating the system functionality under frequently changing EEPROM settings.
If the user wishes to simply read the contents of the EEPROM populated in the current system, this can be achieved through the IDT device without removing the EEPROM from the system. The menu option “Examine” enables the user to read the EEPROM and save the contents in a file which can then be read using the user’s favorite HEX reader, etc.

Figure 13  EEPROM Menu
EEPROM Creation In Detail

This section assumes that users are already familiar with how to modify the register contents in the image of the device registers that the GUI holds at any given time (even if those modified registers are not written to the actual device yet). What is explained is how to save the modified register file in human readable format so it can be visually inspected to insure that proper changes were made to the desired register set, how to convert this file to binary and how to program it into an EEPROM. Majority of the users perform these steps in this sequence and therefore they are explained in some degree of detail here.

It is assumed at this point that the user has modified the registers and is now ready to create an EEPROM image and possibly program the EEPROM in the system itself via the switch upstream port config accesses or via the SMBUS slave access.

After making all of the desired bit changes within a register, double-Right-Mouse-Click on the register name (a green check should now appear to the left of the register name as shown below).

As shown below, under the “File” tab, select “Save As”. Give your new PCIe Browser Register configuration file a name. Typically, the file extension “.cfg” is used to simplify identification of the file contents.

This file is readable via Notepad or any other text editor, and it is recommended that the contents of this file are visually verified for accuracy against intended register values before proceeding to the next step. An example of one such register modification is shown below.
Next under the “EPROM” menu select “Convert to Bin”. The configuration file created in the previous step is automatically converted to a binary file which will appear at the same location on the hard disk as the location of the configuration file. This step is shown below.

The binary file can now be used to program the EEPROM.

Under the “EPROM” menu select “Program” and select the binary file created in the previous step.

Set the appropriate SWMODE on the hardware / board to boot from the EEPROM to reboot the hardware with this EEPROM image.

It is a good idea to verify that the image got programmed correctly into the EEPROM. This can be achieved by reading the EEPROM content once the hardware is powered up with the new EEPROM, saving the content into a binary file and then comparing this binary file with the original file which was programmed into the EEPROM. Here are the steps to achieve this.

Under the “EEPROM” menu, select “Examine” and name the file into which the contents of the IDT device EEPROM should be dumped, as shown below. This saves the EEPROM contents into a binary file.

Next the contents of this EEPROM binary file can be compared with the original binary file used to create the EEPROM.

Under Windows:

Open a DOS box as follows:

Start -> Run
Enter “cmd”

Navigate to the directory where both files are saved and use the fc command to compare files as shown in the next picture.
Under Linux:

Open a terminal window

Navigate to the directory where both files are saved and use the `fc` command as shown below.

```
C:\> cd example
C:\example> fc eeprom_example.bin dump.bin
Comparing files eeprom_example.bin and DUMP.BIN
FC: no differences encountered
C:\example>
```

**Using Help**

Click on the “Help” pull-down menu item from the main screen of the IDT PCIe Browser. Click on the topic of interest from the pull down menu to obtain further help on that topic.
Menu Items Reference

Main Window

- Device
  - Scan --- Re-scan devices
  - Brief --- Display PCI Express specific status of PCI Express device
  - Details --- Display detailed view of IDT PCI Express devices and basic configuration of non-IDT devices
  - Exit --- Exit the program

- Create --- Display detailed view of supported IDT devices and possible configurations in submenu. This is “simulation” only and no real hardware registers are touched. Used to create configuration EEPROM.

Help

- Help --- Display basis help options
- About --- Display information on program such as version number, etc.

Device Window

- File
  - Load --- Load Configuration File
  - Save --- Save current open configuration file in its current name
  - Save-as --- Save a configuration file and give it a specific name
  - Dump --- Copy all register values into a text file
  - Fill --- Fill all registers with values read from a text file
  - About --- Display information about device
  - Exit --- Close window

- EPROM
  - Convert to BIN
  - Program
  - Examine

- Refresh (works only when a real device is present in the system)
  - Register --- Update display of selected register by actually reading from register
  - Port --- Update display of selected port by actually reading from port
  - Device --- Update display of all devices by actually reading from devices
  - Settings --- Allow users to set up periodically updating display in above ranges

- Store (same as Refresh, without Settings, but performs “write” operations instead of “read” operations)
IMPORTANT NOTICE AND DISCLAIMER

RENESAS ELECTRONICS CORPORATION AND ITS SUBSIDIARIES (“RENESAS”) PROVIDES TECHNICAL SPECIFICATIONS AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS” AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT OF THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for developers skilled in the art designing with Renesas products. You are solely responsible for (1) selecting the appropriate products for your application, (2) designing, validating, and testing your application, and (3) ensuring your application meets applicable standards, and any other safety, security, or other requirements. These resources are subject to change without notice. Renesas grants you permission to use these resources only for development of an application that uses Renesas products. Other reproduction or use of these resources is strictly prohibited. No license is granted to any other Renesas intellectual property or to any third-party intellectual property. Renesas disclaims responsibility for, and you will fully indemnify Renesas and its representatives against, any claims, damages, costs, losses, or liabilities arising out of your use of these resources. Renesas’ products are provided only subject to Renesas’ Terms and Conditions of Sale or other applicable terms agreed to in writing. No use of any Renesas resources expands or otherwise alters any applicable warranties or warranty disclaimers for these products.

(Rev.1.0 Mar 2020)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Contact Information
For further information on a product, technology, the most up-to-date version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/

Trademarks
Renesas and the Renesas logo are trademarks of Renesas Electronics Corporation. All trademarks and registered trademarks are the property of their respective owners.

© 2020 Renesas Electronics Corporation. All rights reserved.